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Overview
Submit It 2000 is a small utility that will help automate the process of submitting shareware and freeware to software web sites 
on the World Wide Web.

Submit It comes pre-configured for many of the major software web sites. Use these pre-defined web sites or add your own.

Submit It can also be used to generate automated email notification messages and optional FILE_ID.DIZ information files as well
as HTML web pages and meta tag files.

Submit It 2000 is fully Y2K compliant and will run on MS Windows Millenium Edition and 98 as well as 95/NT and Windows 2000
systems.

Purchasing Submit It
Submit It 2000 is a fully functioning program. It is not crippled in any way.

Submit It 2000 is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days you are required to 
register it. If after evaluating Submit It for 30 days you decide not to register it you are required to remove the program from your 
computer.

Registration entitles you to unlimited free updates and support via E-Mail or telephone.

You may also purchase Submit It 2000 using your credit card via the Internet or by telephone.



Installing Submit It
Installation
To install Submit It 2000 on your computer simply create a new, empty folder and place the files; SUBMITIT.EXE, SUBMITIT.HLP
and SUBMITIT.CNT there.

SUBMITIT.EXE The Submit It Application
SUBMITIT.HLP The Windows Help File
SUBMITIT.CNT The Help Contents File

If you installed Submit It 2000 using the SETUP.EXE program and selected the default installation setting Submit It 2000 will be 
installed in the C:\Program Files\Software by Design folder.

Note If you have an earlier version of Submit It 2000 installed on your computer, simply replace the SUBMITIT.EXE, 
SUBMITIT.HLP and SUBMITIT.CNT files with the newer versions.

The various application settings specified in the Submit It Options property sheet as well as the main window’s location on the 
desktop are stored in the MS Windows 95/NT System Registry.

Warning If you rename the SUBMITIT.EXE file you must also rename the SUBMITIT.HLP file using the same basename. For 
example if you change the Submit It application file name to NewName.exe, rename the help file to NewName.hlp. Do not 
rename the SUBMITIT.CNT file however. The HLP and CNT files must reside in the same folder as the Submit It application file 
itself.

The MS Windows 95/NT Help program creates a pair of files associated with the SUBMITIT.HLP file. These files will have file 
extensions of GID and FTS. These files are used to store specific information about the help window location on the desktop and
the word list used for topic searching. These two files will be created when the Submit It 2000 Help file is first used.



Configuring Submit It
Submit It Options
Select the Options Tab to display the Submit It Options property sheet. This window will allow you to change the various Submit 
It program settings listed below. The program settings you specify here are saved and used each time you run Submit It 2000.

Sort Recent Submission List by File Name
Check this box to sort the Recent Submission List by file name. If this item is not checked submission files will appear in the 
list in the order of last use.

Keep Window Topmost on the Desktop
Check this box to place the Submit It 2000 window in front of all other windows on the desktop.

Send E-Mail Notifications Before Exiting
Check this box to send automated email submission notifications to all web sites specified.

Generate a FILE_ID.DIZ Information File
Check this box to generate a FILE_ID.DIZ information file based upon information specified for the current program 
submission.

Log All E-Mail Operations to Disk
Check this box to create a written log file of all email notification messages transmitted.

Play Sound Effects when Copying Fields
Check this box to play an SLR camera shutter sound when copying individual fields to the MS Windows Clipboard.

Warning Sounds with Dialog Boxes
Check this box to play a short beep sound when Submit It displays a warning dialog box or an error occurs.



Creating a Submission File
Creating a Submission File
To create a new software submission file double-click your mouse on the Submit It program icon. The dialog box shown below 
will be displayed when Submit It 2000 is launched.

Press the [New Submission File] button to start creating a new submission file. The standard MS Windows File Browser will 
then be displayed. Use this window to specify the location and name of the new software submission file being created.

By default software submission files have a file extension of .SUB. This file extension will be added automatically if you don’t 
specify one. It is recommended that you use the .SUB extension so that document files you create can be opened and loaded 
with Submit It automatically from the MS Explorer.

The file name you specify will be used as the basename for the other files created. If you wanted to create a software 
submission file for a program named CoolTool the following files would be created:

CoolTool.sub - Software Submission File
CoolTool.html - Software Web Page
CoolTool E-Mail.txt - Software Submission E-Mail Text
CoolTool Description.txt - Software Submission Description Text
FILE_ID.DIZ - Program Information File

These files will all be created in the same folder as the main .SUB file itself. The contents for these files will be generated and 
then updated as you make changes to the main .SUB file.

When the new software submission file has been created the Submit It 2000 main window will be displayed. Use the tabs 
located at the top of this window to specify information about the program being submitted.



Loading a Submission File
Loading a Submission File
To load an existing software submission file double-click your mouse on the Submit It document icon, or run the Submit It 
program itself.

If you launch the Submit It program the dialog box shown below will be displayed when Submit It 2000 is launched.

Pick a submission file for the Recent Files list or press the […] button to select a submission file using the standard MS Windows
File browser window.

When the software submission file has been loaded the Submit It 2000 main window will be displayed. Use the tabs located at 
the top of this window to specify information about the program being submitted.



Sending E-Mail Submission Notices
Sending E-Mail Submission Notices
To send email submission notices once you have completed filling out the various program information property sheets simply 
press the [OK] button at the bottom of the main window.

Note The Send E-Mail Notifications Before Exiting setting on the Options property sheet must be checked to generate email 
messages for those webmasters specified on the Web Sites property sheet.

Before exiting, Submit It 2000 will invoke your Internet E-Mail Client software, displaying the software submission notification 
message to be sent to all selected webmasters.

Configuring Your E-Mail Client Software
Submit It 2000 has integrated Internet eMail facilities. To use these integrated functions your Internet eMail client must be 
configured as the default Simple MAPI client. In Microsoft Outlook and Outlook Express check the options:

[x] Make Outlook Express my default e-mail program
[x] Make Outlook Express my default Simple MAPI client

To configure these settings use the MS Outlook Express Tools | Options menu command and then select the General tab.

If you use a different email client check the documentation that accompanied the program for more information regarding simple 
MAPI client settings.



Web Site Submissions
Web Site Submissions
Submit It for Windows can be used to submit program information to individually selected software web sites. Select the Web 
Sites property sheet and pick the web site you wish to submit your program to.

Press the […] button to the right of the Submit Form entry field to automatically launch your web browser and go directly to that 
web site’s submit form.

Every webmaster uses a slightly different approach to formatting and gathering information about programs submitted to their 
web site. Submit It has recorded information for most of the types of information a web site might require.

With the web site’s submit form displayed in your web browser and the Submit It program running on the desktop next to your 
browser, simply copy the required program information using the buttons to the left of most entry fields on Submit It property 
sheets, and then paste (Ctrl+V) it into the corresponding field on the submission form.

Note The buttons to the left of most entry fields can be used to copy the respective information directly to the MS Windows 
Clipboard. From there it can be easily pasted into HTML submission forms.



Publisher Information
Publisher Information
Select the Publisher Tab to display the Submit It Publisher Information property sheet. This window will allow you to specify 
publisher information as listed below. The program settings you specify here are saved and used each time you run Submit It 
2000.

Author
Use this entry field to specify the author’s name for the program being submitted.

Company
Use this entry field to specify the name of the company for the program being submitted.

Contact
Use this entry field to specify a contact person’s name for the program being submitted.

Address 1
Use this entry field to specify the street address of the author or company for the program being submitted.

Address 2
Use this entry field to specify additional mailing address information for the author or company of the program being 
submitted.

Post Office
Use this entry field to specify the city, state and postal code of the author or company for the program being submitted.

Telephone
Use this entry field to specify the telephone number of the author or company for the program being submitted.

FAX Line
Use this entry field to specify the FAX number of the author or company for the program being submitted.

E-Mail
Use this entry field to specify the email address of the author or company for the program being submitted.

Web Site
Use this entry field to specify the web site home page of the author or company for the program being submitted.

Note The buttons to the left of these entry fields can be used to copy the respective information directly to the MS Windows 
Clipboard. From there it can be easily pasted into HTML submission forms.



Program Information
Program Information
Select the Application Tab to display the Submit It Application property sheet. This window will allow you to specify application 
information as listed below.

Program
Use this entry field to specify the full name of the program being submitted.

Version
Use this entry field to specify the version number of the program being submitted.

Size
Use this entry field to specify the file size of the program being submitted. The size specified here should be the size of the 
download file itself, not its expanded and installed size.

KB
Check this box if the size field specifies the file’s size in kilobytes.

MB
Check this box if the size field specifies the file’s size in megabytes.

Bytes
Use this entry field to specify the file size of the program being submitted. The size specified here should be the size of the 
download file itself in bytes.

Release
Use these entry field to specify the release date of the program being submitted.

Freeware
Check this box if the program being submitted is distributed as freeware.

Shareware
Check this box if the program being submitted is distributed as shareware.

Cost
Use this entry field to specify the cost of the program being submitted. This item will be disabled (grayed) if the program being 
submitted is distributed as freeware.

Time-Limited
Check this box if the program being submitted has a time limit. This item will be disabled (grayed) if the program being 
submitted is distributed as freeware.

Days
Use this entry field to specify the time period limit (in days) of the program being submitted. This item will be disabled (grayed)
if the program being submitted is distributed as freeware or the Time-Limited box is not checked.

Windows
Use the check boxes to the right to specify the versions of MS Windows this program runs on. Options are included for most 
of the available MS Windows operating systems currently in use. If you are submitting a program that does not run on MS 
Windows systems use the Requires entry field below to specify the operating system this program requires.

Has a Setup
Check this box if the program being submitted has a setup utility included.

Has Uninstall
Check this box if the program being submitted has integrated uninstall facilities.

Requires
Use this entry field to specify any special requirements for the program being submitted.

Note The buttons to the left of these entry fields can be used to copy the respective information directly to the MS Windows 
Clipboard. From there it can be easily pasted into HTML submission forms.



Program Description
Program Description
Select the Description Tab to display the Submit It Description property sheet. This window will allow you to specify application 
description information as listed below.

Synopsis
Use this entry field to specify a short one-line synopsis of the program being submitted. The synopsis should be a succinct 
sentence describing in brief exactly what the program does.

Description
Use this entry field to specify a full description of the program being submitted. This field can contain up to 2048 (2K) 
characters of text. This field does not use hard line feeds. The text will be wrapped automatically to fill the field.

Keywords
Use this entry field to specify keywords for the program being submitted. Most web sites require that keywords be separated 
by a space.

New Features
Use this entry field to specify new features of the program being submitted. If the program being submitted is a new release 
use this field to state that fact.

Note The buttons to the left of these entry fields can be used to copy the respective information directly to the MS Windows 
Clipboard. From there it can be easily pasted into HTML submission forms.



Program Category
Program Category
Select the Category Tab to display the Submit It Category property sheet. This window will allow you to specify application 
category information as listed below.

Primary Program Category
Select a program category from the list that best describes the program being submitted.

Alternate Program Category #1
Select an alternate program category from the list that describes the program being submitted.

Alternate Program Category #2
Select a second alternate program category from the list that describes the program being submitted.

Custom Program Category
Use this entry field to specify an ad hoc category that describes the program being submitted.

Note The buttons above these combo boxes can be used to copy the respective information directly to the MS Windows 
Clipboard. From there it can be easily pasted into HTML submission forms.



Program File URLs
Program File URLs
Select the File URLs Tab to display the Submit It File URLs property sheet. This window will allow you to specify application 
URL File information as listed below.

Download
Use this entry field to specify the download URL for the program being submitted. This must be the URL to the download file 
itself, not the program’s description page. These URLs should have a format similar to; http://www.domain.com/program.zip.

Alternate 1
Use this entry field to specify an optional alternate download URL for the program being submitted.

Alternate 2
Use this entry field to specify a second alternate download URL for the program being submitted.

FTP Site
Use this entry field to specify the FTP download URL for the program being submitted. This must be the URL to the download 
file itself, not the program’s description page. These URLs should have a format similar to; 
ftp://www.domain.com/program.zip.

Alternate 1
Use this entry field to specify an optional alternate FTP download URL for the program being submitted.

Alternate 2
Use this entry field to specify a second alternate FTP download URL for the program being submitted.

Web Page
Use this entry field to specify the HTML description home page for the program being submitted.

Icon Image
Use this entry field to specify an optional icon image for the program being submitted. This URL should have a format similar 
to; http://www.domain.com/program.gif.

Screen Shot
Use this entry field to specify an optional screen shot for the program being submitted. This URL should have a format similar 
to; http://www.domain.com/program.gif.

Note The buttons to the left of these entry fields can be used to copy the respective information directly to the MS Windows 
Clipboard. From there it can be easily pasted into HTML submission forms.



Program Notes
Program Notes
Select the Notes Tab to display the Submit It Notes property sheet. This window will allow you to specify application notes and 
comments as listed below. The notes and comments you record here will not be included in software submission notices. They 
are provided for private use

Note #1    …    Note #9
Use these entry fields to record short notes and comments about the program being submitted. This information will not be 
included in software submission notices.

Note The buttons to the left of these entry fields can be used to copy the respective information directly to the MS Windows 
Clipboard. From there it can be easily pasted into HTML submission forms.

Note You can customize the button labels for these notes by editing the values stored in the MS Windows System Registry. To 
edit these labels make sure SubmitIt is not running. Run RegEdit and locate the key:

HKEY_CURRENT_USER
Software

Software by Design
Submit It for Windows 95/NT

Options
Notes

Label #1 = Note #1
…
Label #9 = Note #9

Edit the data associated with key names Label #1 … Label #9 to create your own custom button labels.

Web Site URL fields can also be defined. Locate the key:

HKEY_CURRENT_USER
Software

Software by Design
Submit It for Windows 95/NT

Options
Notes

IsURL 1 = 1 for TRUE, or 0 for FALSE
…
IsUrl 9 = 1 for TRUE, or 0 for FALSE

Notes marked as isURL = TRUE will enable the browse […] button to the right of the field. Press this button to go directly to that 
specific web site URL. This facility can be useful to check on posted updates. For example, if you submit a program to 
WinFiles.com, placing the URL to the page that the software is listed on will allow you to quickly see if a posting or update has 
been processed.



Software Web Sites
Software Web Sites
Select the Web Sites Tab to display the Submit It Web Sites property sheet. This window will allow you to specify the software 
web sites you wish to submit your programs to. Web Site information is stored in the MS Windows System Registry and will be 
available for all program submissions you make.

Submit It 2000 comes pre-configured with several of the major software web sites. You may also add web sites of your own 
choosing using the settings described below.

Web Site
Select a web site for this list, or select an Undefined entry to add a new web site to the list. The web site you select will be 
reflected in the fields displayed below.

Site Name
Use this entry field to specify the name of this web site.

Contact
Use this entry field to specify the web master’s name for this web site. If you don’t know the name of the webmaster use 
Webmaster for this entry.

E-Mail
Use this entry field to specify an email address for this web site. The email address you specify should be for software 
submission notifications.

Note Not all software web sites allow software submission notices via email, check with the site’s web master before sending 
email messages

Send an E-Mail Notification Messages
Check this item to send an email notification message to the web master at this web site.

Home Page
Use this entry field to specify the web site’s home page URL form. Use the […] button to the right of this field to launch your 
web browser and go directly to this URL.

Search Page
Use this entry field to specify the web site’s search page URL form. Use the […] button to the right of this field to launch your 
web browser and go directly to this URL.

Submit Form
Use this entry field to specify the web site’s program submission form. Use the […] button to the right of this field to launch 
your web browser and go directly to this URL.

Description
Use this entry field to optionally describe this web site.



Comments and Upgrades
Comments and Suggestions
If you have comments, questions or find any bugs in Submit It 2000 please feel free to contact me via email or on CompuServe.

Gregory Braun – Software Design

CompuServe: 71613,2175
Email: Gregory_Braun@CompuServe.com
Web Site: http://www.gregorybraun.com
Phone: 1.414.817.6508

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.gregorybraun.com)



Release History
Submit It 2000 Release History

v2.0 Original in-house development and testing of MS Windows 95/NT conversion using the Microsoft Win32 SDK.

v2.1 Added 95/NT splash box for release. Converted individual dialog boxes to a single Property Sheet window.

v2.2 Added MS Windows 95/NT Help file. 

v2.3 Added integrated Internet eMail client support for automated email submissions. 

v2.4 Added new software archive sites. Fixed several minor bugs. 

v2.5 Fixed a bug that prevented moving off of the Registration property sheet page if user and organization information was 
not found.

v2.6 Fixed several minor bugs. 

v2.7 Added HTML web page and meta tag file generators. Adds support for MS Windows Millenium Edition and Windows 
2000. Fixed several minor bugs. 

Last Update  March 20th, 2001

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.gregorybraun.com)



System Registry
Submit It 2000 System Registry Key
Submit It 2000 stores configuration settings in the MS Windows 95/NT System Registry. These settings are updated 
automatically while Submit It is running. There is no need to edit these settings manually.

If you insist upon editing these settings, you do so at your own risk. Submit It automatically updates registry entries when it exits.
If you edit these settings make sure Submit It is not running while you edit them. If Submit It is currently running your changes 
will be overwritten when Submit It exits.

Submit It 2000 stores configuration settings in the following system registry key:

HKEY_CURRENT_USER
Software

Software by Design
Submit It for Windows 95/NT

Section
Label = Value

Warning There is no need to edit these settings manually. Submit It will automatically maintain these settings for you. If you do 
edit these, you do so at your own risk.



Removing Submit It
Removing Submit It 2000
If you find that Submit It 2000 does not meet your needs you can remove it from your computer system by simply deleting the 
following files from your hard drive.

All of these files will be located in the folder that you originally installed Submit It in.

The default location for all Submit It 2000 program files is the C:\Program Files\Software by Design folder. Unless you 
specified a different folder when you ran SETUP.EXE you will find the Submit It files there.

SubmitIt.exe Submit It Application.
SubmitIt.cnt Submit It Help Topics File
SubmitIt.hlp Submit It Help File

If you have opened and used the Submit It 2000 Help files your system may contain the following two (2) files. These files are 
created by the standard MS Windows 95/NT Help program WinHlp32.exe. These files may also be safely removed.

SubmitIt.gid MS Windows Help settings file. This file contains the Submit It Help window size and desktop location 
as well as any bookmarks you may have created.

SubmitIt.fts MS Windows Help word database. This file is created when you build a custom word list for Submit It 
Help files. This file is used to search for words and phrases in the Submit It Help files.

Submit It 2000 does not use any custom DLL files or system drivers. If you delete the files mentioned above from your system’s 
hard drive you will have completely removed Submit It from your computer system.



Software Design Web Site
Software Design
You can download the latest versions of all of my software from my web site on the Internet. I post the latest releases of my 
software there first. Click your mouse on the link listed below to visit the Software Design web site.

Software Design Web Site

(http://www.gregorybraun.com)

Software Titles
The following software titles are available at my web site on the Internet and can also be found on CompuServe, ExecPC, MSN 
and ZD Net.

AppPaths for Windows 95/NT (APPPATHS.ZIP)
Audition 2000 (AUDITION.ZIP)
BattleStar 2000 (BSTAR32.ZIP)
BattleStar for Windows (BSTAR.ZIP)
CardBase 2000 (CARDBASE.ZIP)
Disk CleanUp 2000 (CLEANUP.ZIP)
DLL Show for Windows 9x/ME (DLLSHOW.ZIP)
File Editor 2000 (FXEDIT32.ZIP)
File Editor for Windows (FXEDIT.ZIP)
File Shredder 2000 (SHREDDER.ZIP)
FontShow 2000 (FONTSHOW.ZIP)
Go Postal for Windows 95/NT (GOPOSTAL.ZIP)
Icon Extractor 2000 (ICONX32.ZIP)
Icon Extractor for Windows (ICONX.ZIP)
Crypto 2000 (CRYPTO.ZIP)
NoteBook 2000 (NBOOK32.ZIP)
NoteBook for Windows (NBOOK.ZIP)
Password Keeper (PASSKEEP.ZIP)
Phantom Desktop Screen Saver (PHANTOM.ZIP)
Programmer's IDE 2000 (PMAN32.ZIP)
Programmer's IDE (PMAN.ZIP)
Quiz Wizard for Windows 95/NT (QUIZWIZ.ZIP)
Reminders 2000 (REMIND32.ZIP)
Reminders for Windows (REMIND.ZIP)
RGB Editor 2000 (RGB32.ZIP)
RGB Editor for Windows (RGB.ZIP)
Screen Loupe for Macintosh (LOUPE.SEA)
Screen Loupe 2000 (LOUPE32.ZIP)
Screen Loupe for Windows (LOUPE.ZIP)
Stay Live 2000 (STAYLIVE.ZIP)
Submit It 2000 (SUBMITIT.ZIP)
ToolBar 2000 (TBAR32.ZIP)
ToolBar for Windows (TBAR.ZIP)
Touch for Windows (WTOUCH.ZIP)
Tray Tools 2000 (TRAYTOOL.ZIP)
TxEdit 2000 (TXEDIT.ZIP)
WebTime 2000 (WEBTIME.ZIP)
World Radio for Macintosh (WRADIO.SEA)

Note The latest versions of my software programs are always posted on my web site first. Versions found on the other online 
services may be earlier releases.



BBS and Internet Operators
Webmasters
Please upload the original ZIP file intact and title the submission:

"Submit It 2000 v2.7"
--Author Gregory Braun

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.gregorybraun.com)

Note This site also supports anonymous FTP transfers.



What is Shareware
The concept of "Shareware"...
Shareware, also known as user supported software and other names, is a concept not understood by everyone. The author of 
Shareware retains all rights to the software under the copyright laws while still allowing free distribution. This gives the user the 
chance to freely obtain and try out software to see if it fits their needs. Shareware should not be confused with Public Domain 
software even though they are often obtained from the same sources.

If you continue to use Shareware after trying it out, you are expected to register your use with the author and pay a registration 
fee. What you get in return depends on the author, but may include a printed manual, free updates, telephone support, etc. Only 
by paying for the Shareware you use do you enable the Shareware author to continue to support his software and create new 
programs. Considering that the Shareware registration fees are almost always far less than the purchase price of comparable 
commercial software it's obvious that Shareware is a good deal for everyone.

There are real advantages to you in the Shareware system. You get to try out software to make sure it is compatible with your 
hardware and that it fits your needs before you "buy" it with your registration. The author saves the expense of advertising, 
packaging and distribution and passes the savings on to you. Plus, most Shareware authors are much more accessible than 
commercial software sources so that your questions and suggestions are much more likely to be responded to.

Thank you for your support.



Registering Submit It 2000
Registering Submit It
Submit It 2000 is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days you are required to 
register it. If after evaluating Submit It for 30 days you decide not to register it you are required to remove the program from your 
computer.

Registration entitles you to unlimited free updates and telephone support.

You can register Submit It 2000 by mailing the Order Form provided with this software. When you register Submit It 2000 you will
receive your registration code by E-Mail, or optionally you may request that your registration code be mailed to you.

You may also purchase Submit It 2000 using your credit card via the Internet or by telephone.

The software you are currently using is a fully functioning program. As a registered user you will however be able to disable the 
initial splash box that appears when Submit It 2000 is first launched.

To register your copy of Submit It 2000 select the Help | Register menu command. The Shareware Registration Wizard will be 
displayed when this menu command is selected. Use this window to fill in the following entry fields:

User Name
Enter the user name you originally specified when you ordered Submit It 2000.

Organization
Enter the name of your organization as originally specified when you ordered Submit It 2000. If you did not specify an 
organization name leave this field blank.

Registration
Enter the registration code that was provided to you. Enter your registration code exactly as provided. Do not include spaces 
when entering your registration code.

Note The registration code was provided to you when you purchased Submit It 2000. Refer to the notification letter that was 
mailed to you or the E-Mail message you received for your personal shareware registration code.

Show Splash Box at Startup
This box will be initially checked if you have not registered Submit It 2000. When you successfully register your copy of 
Submit It this box will automatically be unchecked for you. If you wish to see the splash box when Submit It is launched return 
to this Registration Wizard and check this box.

OK
Press this button after you have filled out the Shareware Registration Wizard to complete Submit It 2000 shareware 
registration.

Cancel
Press this button to close the Shareware Registration Wizard    without making any changes.

Help
Press this button to open the Submit It Help window and go directly to the Registering Submit It topic.



Purchasing Information
Purchasing Information
Submit It 2000 is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days you are required to 
register it. If after evaluating Submit It for 30 days you decide not to purchase it you are required to remove the program from 
your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register Submit It 2000 by mailing the Order Form provided with this software. When you register Submit It 2000 you will
receive your registration code by E-Mail, or optionally you may request that your registration code be mailed to you.

You may also purchase Submit It 2000 using your credit card via the Internet or by telephone.

The software you are currently using is a fully functioning program. As a registered user you will however be able to disable the 
initial splash box that appears when Submit It 2000 is first launched.

Single User Licensing
Individual users can register Submit It 2000 for $25.00 dollars. If you would also like a 3 ½” floppy disk sent to you please add 
an additional $5.00 dollars. Registration entitles you to unlimited free updates and telephone support. You can always download 
the latest release of Submit It directly from the Software Design web site on the Internet. Print the Submit It 2000 Order Form 
and mail it with your check to become a registered user of Submit It 2000.

Site Licensing
Submit It 2000 can also be registered for use at an entire site for $250.00 dollars. If you would like to install and use Submit It on
multiple workstations at a single location choose this type of licensing. Registration includes a 3 ½” floppy disk and entitles you 
to unlimited free updates and telephone support. You can always download the latest release of Submit It directly from the 
Software Design web site on the Internet. Print the Submit It 2000 Order Form and mail it with your check to become a 
registered user of Submit It 2000.

Corporate Licensing
Submit It 2000 can also be registered for use at multiple sites for $1000.00 dollars. If you would like to install and use Submit It 
on multiple workstations at multiple locations choose this type of licensing. Registration includes a 3 ½” floppy disk and entitles 
you to unlimited free updates and telephone support. You can always download the latest release of Submit It directly from the 
Software Design web site on the Internet. Print the Submit It 2000 Order Form and mail it with your check to become a 
registered user of Submit It 2000.



Submit It 2000 Order Form
To print this order form, press the Print button above, or select Print Topic from the File pull-down menu.

Secure on-line credit card orders can be placed from the Software Design web site.

To order by check, send this order form and a check to:

Gregory Braun
P.O. Box 1307
Milwaukee, WI    53201-1307 U.S.A.

Payments must be in US dollars drawn on a US bank, or you can send international postal orders in US dollars.

All orders are subject to the License Agreement.

Customer information is considered confidential and will not be shared or distributed to any third parties.

Registered users of Submit It 2000 are entitled to unlimited free program updates.

Single User Copy ______ at $25.00 each = ________

Optional 3 ½” Disk ______ at $5.00 each = ________
Site License ______ at $250.00 each = ________

Includes 3 ½” Disk
Corporate License ______ at $1000.00 each = ________

Includes 3 ½” Disk

Wisconsin Residents add 5.5% sales tax: ________

Total Payment: ________

Date ____________________________________

Name ____________________________________

Organization ____________________________________

Shipping Address ____________________________________

____________________________________

City ____________________________________

State ____________________________________

Zip Code ____________________________________

Country ____________________________________

Day Phone ____________________________________

E-Mail Address ____________________________________
[    ] Please send registration code via E-Mail

Comments:





Credit Card Purchases
Credit Card Purchases
You may purchase Submit It 2000 by credit card over the telephone or directly from my web site on the Internet.

On-line Registration
Secure on-line registration using a major credit card is available directly from the Software Design web site. Simply go to the 
Submit It 2000 program description page and click your mouse on the RegNet link. You may register Submit It 2000 using your 
Master Card, Visa, American Express, Discover or EuroCard. Registration keys will be sent to you via eMail.

Telephone Registration
You may also purchase Submit It 2000 toll-free by telephone. Please specify Submit It 2000 when ordering.

Toll-Free: 1.800.999.2734
International: 1.719.576.0123
FAX Line: 1.719.623.0399

RegNet Product Codes
2895 Submit It Single User License

RegNet Pages
Single User http://www.reg.net/product.asp?ID=2895

Web Site
Click your mouse on the underlined link below to purchase Submit It 2000 by credit card.

Software Design Web Site

(http://www.gregorybraun.com)



License Agreement
License Agreement

You should carefully read the following terms and conditions before using this software.    Unless you have a different license 
agreement signed by Gregory Braun, your use of this software indicates your acceptance of this license agreement and 
warranty.

Registered Version
One registered copy of Submit It 2000 may either be used by a single person who uses the software personally on one or 
more computers, or installed on a single workstation used nonsimultaneously by multiple people, but not both.

Site License
Any number of users at a single location may access the registered version of Submit It 2000 through a network, provided that
you have obtained a site license for the software covering all workstations that will access the software through the network. 
Any number of users at a single location can install and use the software on one or more computers or workstations.

Corporate License
Any number of users at any number of locations may access the registered version of Submit It 2000 through a network, 
provided that you have obtained a corporate license for the software covering all workstations that will access the software 
through the network. Any number of users at any number of locations can install and use the software on one or more 
computers or workstations.

Software Updates
Registered users of Submit It 2000 are entitled to unlimited free program updates. Software updates can be downloaded 
directly from the Software Design web site on the Internet. Registered users are also entitled to free E-Mail and telephone 
support.

Governing Law
This agreement shall be governed by the laws of the State of Wisconsin.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO 
PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. NO 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data before relying on it. The user
must assume the entire risk of using the program.    ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO 
PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.



Customizing Help
Customizing Help
You can customize this help file to better suit your needs and uses. The following topics describe the various settings that can be
configured. The settings you specify will be saved and used again each time you view this help file.

Font Size
The size of the font used in this help file can be made larger or smaller by selecting the Font item from the Options menu 
above. Select Small, Normal or Large fonts from the popup menu. The font size you select will be saved and used again each 
time you view this help file.

Window Size
The size of this Help window and its location on the desktop can be adjusted using the standard Windows resizing and 
placement methods. The window size and its location on the desktop will be saved and used again each time you view this help 
file.

Window Background Color
The background color for this help window can be changed to white if you prefer. To change the background color to white select
the Use System Colors item from the Options menu above. For the color changes to take effect you will have to close and 
then reopen the Help file. You will be prompted to confirm this action. Your background color selection will be saved and used 
again each time you view this help file.

Window Placement
By default this help window positions itself in front of all other open windows. If you would prefer to have it covered up by other 
active windows select the Keep Help on Top item from the Options menu and then select Not on Top from the popup menu. 
Your selection will be saved and used again each time you view this help file.






